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Glossary of Terms

All defined terms are listed here.

DLL File
EXE File
Icon Library
ICA Library
ICL Library
ICO File
IL Library
IML Library
IMZ Library
NIL Library
Scratch File
Transparency
ZIP Library



Registration Information

IconMaster is not free.    It is copyright 1991, 1992 and is distributed as shareware. You may 
use it to evaluate its suitability to your needs.    If you continue to use IconMaster beyond a 
reasonable evaluation period, you must register it. 

The registration fee for IconMaster is $20.00 ($25.00 outside the US).    For this fee you 
receive the right to use IconMaster on a single computer.    

When you register, you will receive a copy of the latest version along with a personalized 
registration code to make registration reminder messages go away.    

When you receive your registration code number, use the Register command dialog in the 
Help menu and enter this number.    When entered correctly, IconMaster will never again 
bother you with a reminder to register.

An IconMaster Icon Library of over 2500 icons in IMZ format is available along with 
registration for an additional $10.00.

A handy registration form, with full registration details, is in the file REGFORM.TXT.    It can 
be accessed from the Help - Order Form command.    Please use this form, or a reasonable 
facsimile, when registering.

If for some reason the registration form is missing, just mail your registration with a check 
or money order in US dollars to:

Phillip A. Kaufman
19987 Moran Lane
Saratoga CA    USA
95070

We appreciate and encourage all comments, suggestions, and bug reports.    Both your 
registration and your comments will help to improve IconMaster and keep it on the leading 
edge.



Preview Window Overview

Preview windows allow viewing and managing icons from multiple sources.    Up to four 
separate preview windows can be open at one time.    

The Preview display consists of rows of actual-sized icons on a selectable color background 
along with the name of each icon.    The number of icons shown at once is determined by 
the size of the window and the resolution of the display.    On a 1024 X 768 display you can 
see upwards of 150 icons at once!    If all of the icons won't fit in the window, a scroll bar is 
shown in the normal fashion.

The path and name of the open file is displayed in the window header.    If the path is too 
long to fit, it is shortened and begins with ellipses (...).    Any file type not supported for 
writing, e.g. ICA, IL, is opened into a Scratch window.    

With preview windows you can:
Open up to 400 icons per window.
Open icons from many different file types.
Edit any icon.
Drag-and-drop icons between preview windows just like you drag files in the File 

Manager.
Drag icons into the Program Manager or Norton Desktop for Windows (Install) to 

replace whatever icon was previously used for a program or file.    

Double-clicking on an icon in a preview window opens the icon for editing in the edit 
window

At any given time one icon in the preview window is selected.    The selected icon is shown 
with a box around it.    The selection can be changed by clicking on another icon or by using 
the arrow keys.    All Icon menu commands apply just to the selected icon.

There are two types of sources for preview icons; multiple individual ICO files in a directory, 
and the multiple icons inside an EXE file or one of the many icon library file types. The File 
Open command dialog contains radio buttons to allow you to specify the type of file(s) to be
opened.    The File SaveAs command lets you choose the format to save.    Thus, you can 
convert formats by reading    one and writing another.



Drag and Drop Operations
Preview Window

Many operations can be performed most effectively by simply dragging the selected icon to
another window.    Preview windows support several types of drag and drop operations:

Copy (between Preview windows)
Dragging an icon from one Preview window to another while holding down either the 
Shift or Control key copies it into the destination window.

Move (between Preview windows)
Dragging an icon from one Preview window to another moves it into the destination 
window.    It is deleted from the source window.

Edit 
Dragging an icon from a Preview window to the Edit window opens the selected icon in 
the Edit window.    This is identical to the Icon Edit command.    Double clicking on an 
icon is another way to open it into the Edit window.

Install
Dragging the selected icon from a Preview window to a Program Manager or Norton 
Desktop window begins the installation process.    This is identical to the Icon Install 
command.

To drag, select an icon with the mouse and move the cursor while holding down the left 
mouse button.    Release the button at the desired point.

Since EXE icons can not be deleted, a drag from an EXE Preview window will always be 
done as a COPY.

Dragging to the Edit window, the Program Manager or Norton Desktop window is 
independent of Shift and Control and never deletes the icon in the original window.

When dragging, the cursor will turn into a moving van.    As the moving van cursor moves to
different points on the screen a letter will appear on the side of the van indicating the drop 
operation (what happens if you release the mouse button) that will take place at that point:

No Letter - Nothing happens if dropped.

C - Copy - The cursor is in another Preview window and either the Shift or Control Key is 
depressed or the source is an EXE which forces Copy.

E - Edit - The cursor is in the Edit window.

I - Install - The cursor is in the Program Manager or a Norton Quick Access window.

M - Move - The cursor is in another Preview window.    Neither the Shift nor Control Key is 
depressed and the source is not an EXE.

X - The cursor is over something else.    Nothing happens and a Beep warning is given.

When dragging into an ICO or ZIP window, it does not matter where in the target window 
you release the mouse button.    The drag always adds the icon to the target window.    



When dragging into an EXE, IML, IMZ or SCRATCH Preview window, the behavior is 
somewhat more flexible, and complex.    As you drag across the target window the selected 
icon in the target window changes.    If you release the mouse while on top of a target 
window icon it will be replaced.    If you are in the target window, but not on top of an icon, 
you will add the icon to the window!    Before a replace is done, a dialog box will pop up to 
let you confirm the replacement or force an append.

Icons can not be added to EXE files, they can only be replaced.    Therefore, the cursor will 
indicate C or M only when it is actually on a target EXE window icon.

You can not drag a ~DELETED icon to a Preview window containing an ICO or ZIP.    You must
rename the ~DELETED icon first.    You can drag a ~DELETED icon to Preview windows 
containing other types of files.



Preview Window Menus

File - Manipulate icon library files and groups of ICO files.

Icon.-.Manipulate individual icons.

Bkgrnd - Set window background color.

Window - Arrange, open, and select windows.



Preview Window Keys

The following keys are active in the Preview window:

Delete Delete selected icon from disk
(Same as Icon Delete command)

Up, Down, Left, Right Move the icon selection
(Will scroll the display if necessary)

When all icons will not fit on the screen at once, a scroll bar appears and the 
following keys are active:

PageUp, PageDown Scroll the icon display a full screen

Home, End Scroll the display to show first (last) icon.

Note that scrolling does not change the selected icon so the selected icon may be off 
screen.



File Menu Commands
Preview Window

The File menu contains commands for manipulating icon library files and groups of ICO files.

New Scratch
Open a new empty scratch file.

Open
Use the Open Dialog to open an existing file.

Refresh
Re-read the current file.

Save As
Use the SaveAs Dialog to save the current file(s).

Exit
Quit IconMaster.



New Scratch Command
Preview Window - File Menu

Opens a new empty scratch file in the current preview window.

A save query will be given first if the previous contents of the window have not been saved.



Open Command
Preview Window - File Menu

Brings up the Open Dialog to allow opening of any of the various file types supported by 
Preview.

A save query will be given first if the previous contents of the window have not been saved.



Refresh Command
Preview Window - File Menu

Re-reads the current file and updates the display.    Formats other than EXE and DLL are 
aplhabetized.

Any ~DELETED icons in an ICO or ZIP file will be lost.    Any in other formats will simply be 
re-alphabetized last.

Use if the display has become garbled or if the file(s) displayed are altered outside of 
IconMaster while it is running.



SaveAs Command
Preview Window - File Menu

Brings up the SaveAs Dialog to allow saving the current file(s) in any of the various file write
formats supported by preview.

Use to change file formats.

Can also be used to remove deleted icons from IML and IMZ files by doing SaveAs to the 
original file name.



Exit Command
Preview Window - File Menu

Closes all IconMaster windows and terminates the application.

Note that the Close command in the System Menu, or double-clicking the System Menu 
icon, closes only the current window, as opposed to the Exit command which closes all open
IconMaster windows.

A save query will be given first if the previous contents of any of the windows have not 
been saved.



Icon Menu Commands
Preview Window

The Icon menu contains commands for manipulating individual icons.    These commands 
operate on the selected icon as indicated by the outline box around the icon.

Rename
Change the name of the selected icon.

Copy to
Copy the selected icon to an ICO file.

Move to
Move the selected icon to an ICO file.

Delete
Delete the selected icon.

Edit
Open the Edit window with the selected icon.

Install
Replace a Program Manager or Norton Desktop icon with the selected icon.



Rename Command
Preview Window - Icon Menu

Brings up the Rename dialog box to change the name of the currently selected icon.

Rename can only be used to change the name of an icon within an icon library , or to 
change the name of an ICO file.    Rename can not be used to copy or move an icon.

Icons in EXE files can not be Renamed.

Caution: Icon and file names can have no more than eight characters (plus a three 
character extension for files).    You can enter more characters, but extras will be discarded.



Copy to Command
Preview Window - Icon Menu

Brings up the Copy to dialog box to copy the currently selected icon to an ICO file.

Copy to can be used to convert a single icon from any format into an ICO format.



Move to Command
Preview Window - Icon Menu

Brings up the Move to dialog box to move the currently selected icon to an ICO file.

The currently selected icon is deleted from the original library or directory!



Delete Command Del
Preview Window - Icon Menu

Deletes the currently selected icon.

Deleted icons continue to be displayed, using the name ~DELETED, as long as the window 
is open and another file has not yet been read into the window.    

Refreshing when ICO or ZIP files are displayed causes the ~DELETED icons to be discarded. 
For other file formats Refreshing simply.causes ~DELETED icons be alphabetized last.

~DELETED icons can be recovered by Renaming them! 

You can drag a ~DELETED icon to another Preview window as long as the target window 
does not contain ICO or ZIP icons.    In that case you must rename the ~DELETED icon first.

IML file closing speed is optimized by not actually removing deleted icons from the IML 
library.    An icon deleted from an IML library is simply marked ~DELETED but it still exists in 
the library and will show up the next time the library is opened.    To compact the library and
completely remove ~DELETED icons, do File SaveAs to the same file name.



Edit Command
Preview Window - Icon Menu

Opens the Edit window and places the currently selected icon into it for editing.

If the Edit window is already open, the icon previously being edited will be replaced.    A 
save query will be given first if the previous contents of the Edit window have not been 
saved.



Install Command
Preview Window - Icon Menu

Replaces an icon in a Program Manager group window or Norton Desktop    Quick Access 
window with the currently selected icon.

In Program Manager, you can use Install to replace file and program icons that are shown in
group windows.    You can not Install a new icon for the one used to show groups in the main
window.    

In Norton Desktop you can use Install to replace program, file, or group icons in Quick 
Access windows.    You can not use Install for tool buttons or drive icons.

Note: If both the Program Manager and Norton Desktop are running, Install will use Norton 
Desktop.    You can only install to the Program Manager if Norton Desktop is closed.

A dialog box is displayed asking you to highlight the icon to be replaced in the Program 
Manager or Norton Desktop and then to press OK.

If neither the Program Manager nor Norton Desktop is running, an error message will be 
given.

If the current icon edits have not been saved as an ICO, EXE, or DLL file, you will be given a 
chance to do so.    (Program Manager and Norton Desktop can not directly read library files 
other than ICO and those that are actually EXE files without any program in them.)

See also:
Program Manager Icons
Norton Desktop Icons



Bkgrnd Menu
Preview Window

Changes the window's background color.

The Bkgrnd menu shows 16 color boxes, rather than normal menu text.    Select the desired 
color just as you would for an ordinary menu entry.

The current color is shown with an X drawn through it.

Icons are displayed transparently over the background color.

The color selected for each window will be saved when the window is closed.



Window Menu Commands
Preview Window

The Window menu contains commands to arrange, open, and select IconMaster windows.

Cascade
Size all open IconMaster windows and arrange in a stack.

Tile
Size all open IconMaster windows and arrange as tiles.

New Preview
Open another Preview window.

Edit Window
Open and switch to the Edit window.

Active Windows List
Switch to another active IconMaster window.

All IconMaster window sizes and positions are saved when the program quits and will 
automatically be used the next time IconMaster is opened.    If you change screen resolution
between invocations of IconMaster you may need to do Tile or Cascade to get all of the 
windows back onto the screen.



Cascade Command
Preview Window - Window Menu

Automatically sizes all active IconMaster windows and arranges them so that the caption 
bar of each can be seen.



Tile Command
Preview Window - Window Menu

Automatically sizes all active IconMaster windows and arranges them so that all of the 
active Preview windows can be seen at once.

The Edit window, if open, will be placed in the center of the screen.



New Preview Command
Preview Window - Window Menu

Opens a new Preview window displaying a new empty scratch file.

A maximum of four Preview windows can be opened at one time.    If all four are already 
open this command is disabled.



Edit Window Command
Preview Window - Window Menu

Switches the focus to the Edit window.

If the Edit window is not already open, it will be opened with an untitled icon.

Note that all IconMaster allows only one Edit window.



Active Windows Commands
Preview Window - Window Menu

A menu item appears for each open Preview window, allowing you to switch easily between 
windows.

The active window menu entries are numbered (1 through 4) and show the name of the file 
opened in the window.



SaveAs Dialog

The SaveAs Dialog contains the standard Files and Directories list boxes and a File Name 
edit box.    In addition, a File Type box contains radio buttons for the four different types of 
files that can be saved (ICO, IML, IMZ, and ZIP).    

When doing SaveAs from the Edit Window only the ICO format is enabled.

The SaveAs Dialog also contains a Create Directory button to allow creating a new directory
prior to saving a file.

The FileName and File Type will default to that of the currently opened file.    Changing the 
File Type will change the file extension appropriately.    When saving    ICOs from the Preview 
window the File Name must be *.xxx so that all of the icons can be written with their own 
names.



Create Directory Dialog

The Create Directory Dialog is invoked from the SaveAs Dialog with the Create Dir button.

Enter a new directory name to create a new directory under the directory currently selected
in the SaveAs Dialog.



Open Dialog

The Open Dialog contains the standard Files and Directories list boxes and a File Name edit 
box.    In addition, a File Type box contains radio buttons for the ten different types of files 
that can be opened.    From the Edit window only the ICO type is enabled.

Selecting a file type causes the Files box to be updated listing all of the files in the current 
directory that have the selected file extension.    You can change the extension in the File 
Name box to display other files that should be opened as though they were of the selected 
type.

When any format other than ICO is selected, the dialog takes the name of a single file and 
opens all of the icons contained in that file.    Select a single file to open by double clicking 
on it in the Files list box, or single clicking it and clicking OK, or entering a name in the File 
Name box and clicking OK.

Since ICO files contain only a single icon, entire groups of ICO files can be opened at once 
into a Preview window.    When ICO is selected for a Preview window, the File Name should 
be a file specification with wildcards.    Clicking OK opens all of the individual ICO files in the 
directory that match the wildcard specification.    Double clicking on a single ICO file name 
will open just that one icon, which probably is not what you want.



Edit Window Overview

The Edit window allows creation and editing of one icon at a time.    There is only one Edit 
window.

The Edit window contains several different areas:
Edit Image - an enlarged view of the icon in which all editing is done
Sample Image - an actual size copy of the icon being edited, shown on a colored 

background
Color Palette - for selecting the drawing colors
Mouse Colors - the colors currently assigned to each mouse button
Tools Palette - for selecting the current drawing tool

See Drawing Techniques for an overview of drawing operations.

The Edit window can be invoked in several ways:
Double click launching of an ICO file
Double clicking an icon in a Preview window
Selecting a Preview window Icon menu Edit command
Selecting a Preview window Window menu Edit Windowcommand



Edit Window Menus

File - Manipulate individual icon files.

Edit.-.Alter icons.

Bkgrnd - Set icon sample background color.

Window - Arrange, open, and select windows.



Edit Window Keys

The following editor keys can be used in lieu of mouse and menu actions:

Escape When using a brush tool, behaves as a third mouse button with Transparent 
color selected

Space or Enter Draw with the Left Button color (Same as Left Button)

Space or Enter plus Control Draw with the Right Button color (Same as Right Button)

Up, Down, Left, Right  Move one pixel

Up, Down, Left, Right plus Shift Draw with the Left Button color

Up, Down, Left, Right plus Control Draw with the Right Button color



File Menu Commands
Edit Window

The File menu contains commands for manipulating individual ICO files and icons.

New
Create a new un-named blank icon.

Open
Use the Open Dialog to open an existing ICO file.

Revert
Restore the icon to the way it was last saved.

Save
Save current edits.

Save As
Use the SaveAs Dialog to save the current icon.

Capture
Make an icon from a part of the screen.

Install
Replace a Program Manager or Norton Desktop icon with the selected icon.

Exit
Quit IconMaster.



New Command
Edit Window - File Menu

Opens a new blank (all transparent) untitled icon for editing.

A save query will be given first if the previous contents of the window have not been saved.



Open Command
Edit Window - File Menu

Brings up the Open Dialog to allow opening of an existing ICO file.

Icons from file types other than individual ICO files can be edited only by dragging them 
from a Preview window.

A save query will be given first if the previous contents of the window have not been saved.



Revert Command
Edit Window - File Menu

Restores the current edit image to the way it was when the icon was last saved.

The current edits can be recovered by using the Undo command.

Disabled if no changes have been made to the icon.



Save Command
Edit Window - File Menu

Saves the current icon edits.    The old image of the icon is lost.

The icon will be saved in its original format.

Disabled if no changes have been made to the icon.



SaveAs Command
Edit Window - File Menu

Brings up the SaveAs Dialog to allow saving the current icon as an ICO file.

SaveAs can only save in ICO form.    Use the Preview window to save multiple-icon file 
formats.



Capture Command
Edit Window - File Menu

Allows capturing an image from the screen and turning it into an icon.

The cursor becomes a 32X32 pixel box outline which can be moved anywhere on the 
screen.    As the cursor moves, the image within the cursor is magnified and shown in the 
edit image.    When the desired image is shown, click to left mouse button to lock it in.    The 
cursor then returns to normal.

You can make fine grained adjustments in the capture image by using the arrow keys to 
move the box cursor and then hitting Enter.



Install Command
Edit Window - File Menu

Replaces an icon in a Program Manager group window or Norton Desktop    Quick Access 
window with the currently selected icon.

In Program Manager, you can use Install to replace file and program icons that are shown in
group windows.    You can not Install a new icon for the one used to show groups in the main
window.    

In Norton Desktop you can use Install to replace program, file, or group icons in Quick 
Access windows.    You can not use Install for tool buttons or drive icons.

Note: If both the Program Manager and Norton Desktop are running, Install will use the 
Program Manager.    You can only install to Norton Desktop if the Program Manager is closed.

A dialog box is displayed asking you to highlight the icon to be replaced in the Program 
Manager or Norton Desktop and then to press OK.

If neither the Program Manager nor Norton Desktop is running, an error message will be 
given.

If the current icon edits have not been saved as an ICO, EXE, or DLL file, you will be given a 
chance to do so.    (Program Manager and Norton Desktop can not directly read library files 
other than ICO and those that are actually EXE files without any program in them.)

See also:
Program Manager Icons
Norton Desktop Icons



Exit Command
Exit Window - File Menu

Closes all IconMaster windows and terminates the application.

Note that the Close command in the System Menu, or double-clicking the System Menu 
icon, closes only the current window, as opposed to the Exit command which closes all open
IconMaster windows.

A save query will be given first if the previous contents of any of the windows have not 
been saved.



Edit Menu Commands
Edit Window

The Edit menu contains commands to alter the edit image.    Most editing is actually 
performed using the tools in the ToolBar.

Undo
Reverse the effect of the most recent edit.

Horiz Flip
Mirror the image left to right.

Vert Flip
Mirror the image top to bottom.

Clear
Clear the image to all transparent.



Undo Command
Edit Window - Edit Menu

Reverses the effect of the last edit to the icon image.

The Undo command is a single level undo, meaning that it can only undo the very last edit 
or draw operation.

The Revert command is also UNDOable.    Thus, you can swap back and forth between the 
original image and the current edit image any number of times.    This is convenient when 
you want to compare the current edited version to the original.

Whenever you do a Save or SaveAs, the revert image is updated to match the saved 
version.    This means that once you save edits the prior version is gone forever.



Horiz Flip Command
Edit Window - Edit Menu

The edit image is flipped about the vertical azis at the center of the icon, i.e. mirrored left to
right.

A flip can be undone with the Undo command.



Vert Flip Command
Edit Window - Edit Menu

The edit image is flipped about the vertical azis at the center of the icon, i.e. rotatted left to
right.

A flip can be undone with the Undo command.



Clear Command
Edit Window - Edit Menu

Clears the icon image to all transparent.

The Clear command can be undone using the Undo command.



Bkgrnd Menu
Edit Window

Changes the background color shown behind the actual-size sample image of the icon 
being edited.

The Bkgrnd menu shows 16 color boxes, rather than normal menu text.    Select the desired 
color just as you would for an ordinary menu entry.

The current color is shown with an X drawn through it.

The color selected will be saved when the window is closed.



Window Menu Commands
Edit Window

The Window menu contains commands to arrange, open, and select IconMaster windows.

Cascade
Size all open IconMaster windows and arrange in a stack.

Tile
Size all open IconMaster windows and arrange as tiles.

New Preview
Open another Preview window.

Active Windows List
Switch to another active IconMaster window.

All IconMaster window sizes and positions are saved when the program quits and will 
automatically be used the next time IconMaster is opened.    If you change screen resolution
between invokations of IconMaster you may need to do Tile or Cascade to get all of the 
windows back onto the screen.



Cascade Command
Edit Window - Window Menu

Automatically sizes all active IconMaster windows and arranges them so that the caption 
bar of each can be seen.



Tile Command
Edit Window - Window Menu

Automatically sizes all active IconMaster windows and arranges them so that all of the 
active Preview windows can be seen at once.

The Edit window will be placed in the center of the screen.



New Preview Command
Edit Window - Window Menu

Opens a new Preview window displaying a new empty scratch file.

A maximum of four Preview windows can be opened at one time.    If all four are already 
open this command is disabled.



Active Windows Commands
Edit Window - Window Menu

A menu item appears for each open Preview window, allowing you to switch easily between 
windows.

The active Preview window menu entries are numbered (1 through 4) and show the name of
the file opened in the window.



Drawing Techniques
Edit Window

All drawing is done in the edit image, an enlarged view of the icon.    The edit image uses a 
special indication for transparent and inverse colors; black with a white dot and white with a
black dot, respectively.    The transparent and inverse dots are at the center of each pixel 
and aid in aligning drawing.

A new, blank, icon always starts out all transparent.

An actual-sized copy of the icon is shown in the sample image on a selectable background 
color.

Drawing is done by first selecting one of the ten drawing tools by clicking on it with the left 
mouse button.    The selected tool will appear depressed.

When drawing, either mouse button may be used.    Each mouse button has an associated 
color shown in the mouse color rectangles below the color palette.    Select a color for each 
mouse button by clicking the button on the desired color in the color palette.    There are 16 
pure colors plus the special transparent and inverse-transparent 'colors'.

Figures (line, rectangles, and ellipses) are drawn by pressing a mouse button at the desired 
starting point, dragging the mouse while holding the button down, and then releasing the 
mouse button at the desired ending point.    When a figure tool is selected, the cursor in the 
edit image will be a cross.

During dragging a phantom figure shows where the actual figure will be drawn when the 
button is released.    For lines, the phantom line is shown thru the center of all pixels that 
will be colored.    For rectangles and ellipses, the phantom figure is shown as the outside 
boundary of the figure that will be drawn. 

The last individual draw can always be undone. using the Undo command in the Edit menu.

The edit image is also effected by the capture tool and by the commands in the Edit menu.



Drawing Tools
Edit Window

The edit window provides ten drawing tools plus a screen capture tool.

The drawing techniques topic describes basic editing and drawing concepts.

    

    

      Brushes    

      Line

    

      Hollow and Filled Rectangle

    

      Hollow and Filled      Ellipse

      Pour (paint can)

      Re-color (roller)

      Capture (camera)



Brush Tools
Edit Window - Drawing Tools

The brush tools select free hand drawing with one of three brush sizes.    They may be used 
to draw individual pixels or continuous free hand figures.

One pixel square brush

Three pixel square brush

Five pixel square brush

To draw free hand:
1. Click on a Brush tool to select brush size.
2. Click once in the Edit Image to draw a single point the size of the brush, or. 
3. Press a mouse button and drag to draw free hand.

(Drawing will be done in the color associated with the mouse button used.)

Note that because of the way Windows supplies mouse move commands to an application, 
figure drawing may have gaps if the mouse is moved too rapidly.



Line Tool
Edit Window - Drawing Tools

The line tool selects straight line drawing one pixel wide.

To draw a line:
1. Click on the Line tool to select it.
2. Press a mouse button at the desired start point.

(The line will be drawn in the color associated with the mouse button used.)
3. Drag to the desired end point.

(During the drag a ghost line appears.)
4. Release the mouse button.



Rectangle Tools
Edit Window - Drawing Tools

The two rectangle tools select hollow and filled rectangle drawing.    

Hollow rectangles are drawn one pixel thick and the inside of the rectangle is not altered.    

Filled rectangles are completely colored in the color of the mouse button used.

To draw a rectangle:
1. Click on the desired Rectangle tool to select it.
2. Press a mouse button at the desired start point.

(The rectangle will be drawn in the color associated with the mouse button used.)
3. Drag to the desired end point.

(During the drag a ghost rectangle appears.)
4. Release the mouse button.



Ellipse Tools
Edit Window - Drawing Tools

The two ellipse tools select hollow and filled ellipse drawing.    

Hollow ellipses are drawn one pixel thick and the inside of the ellipse is not altered.    

Filled ellipses are completely colored in the color of the mouse button used.

To draw an ellipse:
1. Click on the desired Ellipse tool to select it.
2. Press a mouse button at the desired start point.

(The ellipse will be drawn in the color associated with the mouse button used.)
3. Drag to the desired end point.

(During the drag a ghost ellipse appears.)
4. Release the mouse button.



Pour Tool
Edit Window - Drawing Tools

The pour tool (paint can) allows changing the color of a contiguous area having the same 
color as the starting point.    Other non-contiguous occurrences of the color are not changed.

To change the color of an area:
1. Click on the Pour tool to select it.
2. Click a mouse button anywhere inside the areas whose color is to be changed.

(The new color will be the color associated with the mouse button used.)

To change all occurrences of a color to another color use the Re-color Tool



Re-color Tool
Edit Window - Drawing Tools

The re-color tool (roller) allows changing all occurrences of one color to another color.

To change all occurrences of a color:
1. Click on the Re-color tool to select it.
2. Click a mouse button anywhere on the color to be replaced.

(The new color will be the color associated with the mouse button used.)

To change only a contiguous patch of color use the Pour Tool.



Capture Tool
Edit Window - Drawing Tools

The capture tool (camera) initiates capturing of a screen image and turning it into an icon.

Unlike all other tools, the capture tool is not modal.    It stays depressed only during the 
capture operation.

Use of the capture tool is identical to using the File Capture command.

To capture a 32X32 pixel piece of the screen image:
1. Click on the Capture tool to select it.

(The cursor will turn into a 32X32 hollow square and whatever is inside the square 
cursor will appear    magnified in the Edit image area.)

2. Move the cursor over the area to be captured.
(The capture area can be precisely aligned using the arrow keys.)

3. Press the left mouse button, or the Enter key, to lock in the captured area.

Note that the image captured is whatever was actually painted on the screen.    A captured 
screen image will not have any transparent areas, even if you are capturing an image of 
another icon that was drawn with transparency.    You can add transparency easily using the 
Pour or Re-color tools.



Icon Library

A single file that contains a number of individual icons.    When a library is opened in a 
Preview window all of its icons are displayed.    Each icon can be edited and used separately.



ICO File

The Microsoft standard format for a single icon file.    Can contain several styles of an icon 
(different resolutions and number of colors).    Only the 32X32 16-color style is used by 
IconMaster.



IML Library

IconMaster's proprietary format for saving multiple icons in a single file.    IML libraries 
contain icon names and images and are smaller and faster than any other uncompressed 
storage format.



IMZ Library

A ZIPped form of IconMaster's proprietary IML format for saving multiple icons in a single 
file.    IMZ libraries are smaller than any other storage format, but like all ZIPped files take 
longer to read and write.



ZIP Library

A ZIP compressed collection of individual ICO files.    Much smaller than uncompressed files, 
but quite slow to open and close since individual icon files must first be unZIPped and any 
that change must be reZIPped.
(Any files other than *.ICO in a ZIP will be left undisturbed by IconMaster.).



EXE File

Standard Windows executable files usually contain at least one icon.    IconMaster can read 
and modify EXE icons, but can not create EXE files.    EXE icons can not be renamed or 
deleted and additional icons can not be added to an EXE file.



DLL File

Standard Windows dynamic link library files sometimes contain icons.    IconMaster can read
and modify DLL icons, but can not create DLL files.    DLL icons can not be renamed or 
deleted and additional icons can not be added to an DLL file.



ICA Library

A proprietary format used by the program Icon Manager. Similar to IML format but without 
icon names.



ICL Library

A proprietary format used by the program Icon Manager. Similar to an EXE file, but without 
executable code or icon names.



IL Library

A proprietary format used by the program Icon Designer. Similar to an EXE file, but without 
executable code or icon names.



NIL Library

A proprietary format used by the program Norton Desktop. Similar to an EXE file, but 
without executable code or icon names.



Scratch File

A scratch file is an un-named IML library that is maintained in the TEMP directory while it is 
open.

A new Preview window is opened to an empty scratch file.    Scratch files are also created 
when any format library file that is not supported for writing is opened and when the New 
Scratch command is used.



Transparency

Individual pixels in icons can have transparent and inverse transparent attributes.    If 
transparent, the color displayed for the icon pixel is the color of the screen over which the 
icon is written.    This capability enables icons to appear in shapes other than rectangles.

Inverse transparency displays the inverse color of the background over which it is written.    
Outlining an icon in inverse assures that its edges will always stand out against any color 
background.



Invoking IconMaster

IconMaster accepts a single command line argument giving the name of a file, without 
wildcards, with optional path.    If the file name given ends in .ICO, the icon will be opened 
into theEdit window.    If the file name ends in .IML, IMZ, or ZIP, the library will be opened 
into a Preview window. Any other suffix will cause the argument to be ignored and 
IconMaster will open an empty Preview window.

When invoked by double-clicking the EXE file, or with RUN without a file name argument, 
IconMaster starts up with an empty Preview window.

Use Associate in the File Manager to assign ICONMSTR.EXE as the program for *.ICO files, 
then you can invoke IconMaster to edit an icon file by simply double-clicking on the icon 
file.    You can also Associate IconMaster with *.IML, *.IMZ,    and with *.ZIP to double click 
open libraries. (Although you probably won't want to Associate IconMaster with *.ZIP if you 
use ZIP files for anything other than icon libraries.)



Icon Basics

An icon is a special kind of bitmap that Windows uses to identify a program.    When a 
program is minimized Windows displays its icon.    Also, the Program Manager uses icons in 
group windows to identify programs to click launch.

An icon is actually two separate bitmaps; an image and a mask.    The image is a standard 
bitmap.    The mask is a monochrome bitmap that is overlayed on top of the image to 
provide transparency and inverse transparency.    

Some editors force you to work on each of these two bitmaps separately.    IconMaster 
handles them together in a unified fashion so that you need never be aware of the 
underlying representation.    In IconMaster's Edit window, transparent and inverse 
transparent are simply two additional 'colors' that you can draw with.



Icon Styles

Microsoft defines four different styles of icons, for various displays.    The only one widely 
used, and the only one handled by IconMaster, is the 32 X 32 pixel 16-color variety.

Some icons, both in ICO and EXE files, actually consist of more than one style for the icon.    
If you attempt to open an ICO file with multiple styles for editing, you will receive a warning 
and IconMaster will proceed to open just the 32 X 32 16-color style under the name 
"Untitled".    This helps avoid overwriting the original multiple-style file with a single-style 
from IconMaster.

If an EXE file contains multiple styles for an icon, only the 32 X 32 16-color style icon will be
opened.    In the preview window, multiple-style ICO icons are shown with upper case names
to distinguish them.



64 X 64 Icons

Microsoft defines standard icons to be 32x32 pixels.    However, there are some icon authors
who are creating 64x64 icons. Why? Good question. 

There is no known use for a 64x64 icon.    No existing display will use them.    Windows will 
accommodate them by shrinking them to 32x32.    In the process, carefully crafted 64x64 
icons will become quite ugly as windows deletes three quarters of the bits to shrink them.    
As a result, authors of 64x64 icons actually craft them so that they look right when shrunk, 
not at full resolution.

Because 64x64 icons take up four times as much disk space and have no know use, we 
have decided not to support them in IconMaster at this time.



File Types

IconMaster supports ten different types of files that contain icons.

Create, Read, Modify file types:
ICO ICOn files.    
IML IconMaster Library file.    
IMZ IconMaster IML ZIP file.    
ZIP ZIP archive of multiple .ICO files.

Read, Modify file types (no file creation):
EXE Windows executable file.
DLL Windows Dynamic Link Library file.

Read - Only file types (no creation or writing):
ICA ICon Archive
ICL ICon Library
IL Icon Library
NIL Norton Icon Library

You can convert icons from one file format to another by using the Preview window's SaveAs
command and selecting another save format.    You can also save individual icons as an ICO 
file by using the Preview window's CopyTo and MoveTo commands or the Edit window's 
SaveAs command.

If you encounter file formats other than those directly supported, try opening them as 
either EXE, ICL, or ICA files.    In all likelihood they will match one of these.

See File Strategies for information regarding which formats to use.



File Type Strategies

Background

With the many types of icon files available and supported by IconMaster, the question 
always arises "Which formats should I use and when?"    The answer depends upon the 
relative priority that you place on ease of use, disk space, file open and close speed, and 
what you intend to do with your icons.

The simplest way to manage icons is to keep them all as separate ICO files. The ICO format 
is the lingua franca    of icons, everyone can read and write them and they can be attached 
to programs in the Program Manager.    You can easily sort them into different directories to 
keep track of them.    

The problem with ICO files is that they take up an enormous amount of disk space.    
Although a single ICO file contains only 766 bytes, disk organization into sectors and 
clusters means that, depending on disk size, an ICO file will use up from 1K to 4K of disk, 
plus the space for the directory entries. Those 500 little icons you collected could well use 
up over two megabytes of disk space!    ICO files are also relatively slow to open when you 
have hundreds of them.

One way to combat the space used by lots of individual ICO files is to ZIP them.    A ZIP file 
of ICOs is dramatically smaller than all of the individual files (about one fifth the size). Most 
icons found on bulletin boards will be ZIPs of individual ICOs.    IconMaster is unique in its 
ability to automatically unZIP and then reZIP these files.    This makes it quite painless to 
keep your icons ZIPped at all times.    You do pay two penalties.    First, it takes time to unZIP
and reZIP.    Second, you can not directly install icons into the Program Manager or Norton 
Desktop from a ZIP.    You must first save the icon to be installed as an ICO file (IconManager
will, however, do this for you during the install process!).

Various icon programs define their own proprietary icon library formats.    They do this 
primarily to reduce disk space and to increase speed.    There are two general classes of 
icon library formats; Resource files such as ICL, IL, and NIL, and compacted files such as ICA
and IML.    Resource files are reduced forms of EXE files.    They can be used directly by the 
Program Manager and Norton Desktop, but they are much larger than compacted files.    
Compacted files are quite small, but like ZIP files require that you extract and save the 
icons you want to use in some other format.

One limitation of virtually all compacted formats, except IconMaster's IML format, is that 
they do not allow individual icons to carry names.    

IconMaster's IML format is as small or smaller than any other program's compacted library, 
and it is very fast. Faster by far than individual ICO files or resource files.    An IML file will 
typically be one third the size of individual ICO files and about twice the size of a ZIP file.

Even though IML format is very small, IconMaster goes one step further by including the 
IMZ format which is a ZIP of an IML library.    IMZ is absolutely the smallest icon file format 
available. But, you will pay a speed penalty to ZIP and unZIP each time you use the file. The
IMZ speed penalty, however, is much smaller than the speed penalty to ZIP ICO files.    An 
IMZ file will typically be less than one tenth the size of individual ICO files and one half the 
size of a ZIP file.

Recommended Strategies



The "best" strategy for ease of use, speed, and disk space is to maintain all of your icons in 
either IML or IMZ format;    IML for speed, IMZ for absolute minimum disk space.    You might 
want to get the best of both by using IML files while you are actively managing your icons 
and then save them as IMZ files when you are not apt to use them for a while.

It is recommended that you sort your icons by topic so that no more that a few hundred are 
in each file.    More than that makes it quite hard to find the one you want.    You should also 
make a directory to keep ICO copies of any icons that are currently Installed in the 
ProgramManager or Norton Desktop.

If you often share icons with others, and do not know what formats they can handle, then 
you should modify the above strategy and use ICO and ZIP files.    These are the most 
widely used formats.    Although ICOs are very big, they are individually reasonably fast.    
ZIPs are quite small, but also quite slow.



File Refresh and Append

When writing files from a Preview window, IconMaster generally allows you to append 
information to an existing file or directory.    When saving icons to an    IML or IMZ, "append" 
means add the icons being saved to the library.    Because duplicate names are allowed in 
an
IML and IMZ library there will be no conflict.    However, when saving as ICOs or to a ZIP file, 
"append" means replace existing icons with the same name and add the rest of the icons to
the file.    When saving as ICOs there is no actual append/overwrite query; any name 
conflicts
will just result in an overwrite permission query.

Because a SaveAs might involve an implicit append, IconMaster will normally do a full re-
read of the written file(s) immediately after writing so that the display properly shows all of 
the icons.    For example, suppose that you drag a bunch of icons into a Scratch window and 
then do SaveAs and write out the icons as ICOs to some directory.    IconMaster will 
immediately
re-read the directory and display not only the files you just wrote, but any other files that 
may already have been in the directory.



IMZ Renaming

An IMZ file is actually a ZIP of an IML that is automatically created by IconMaster.    The 
name of the IMZ matches the name of the IML file that it contains.    YOU SHOULD NEVER 
RENAME AN IMZ FILE!    If you do, the IMZ    name will not match the IML contained in it and 
IconMaster will not be able to find the icons.    If you need to change the name of an IMZ file,
Open the IMZ in IconMaster and then SaveAs as an IMZ with a new name, then delete the 
original IMZ.

If you find that you have inadvertantly renamed an IMZ and can not remember its original 
name to rename it back, all is not lost.    Change the extension of the IMZ file to ZIP and 
unzip it manually using PKUNZIP.    The result will be an IML that you can open and then 
save as an IMZ.



Program Manager Icons

Note: You can only use the Install command to automatically install icons into Program 
Manager if Norton Desktop is not running.

In Program Manager, you can Install new icons to replace file and program icons that are 
shown in group windows.    You can not Install a new icon to replace the icon used to show 
groups in the main window.    

Windows uses a common icon for all groups.    That icon is in the PROGMAN.EXE file.    You 
can edit the EXE file to replace the icon for groups, but Windows is limited to a common 
icon for all groups.

The Program Manger can only read icons from ICO and EXE files, and from resource files 
that resemble EXE files.    

When you Install an icon into the Program Manager, it makes itself a local copy for speed.    
However, you should keep the readable form around, in the same place it was originally 
read from, so that the Program Manager has access to it.    It will be reread any time you 
make a change to any entry in the Properties dialog.

Normally, when you want to install an icon into the Program Manager you use the Properties
and Change Icon dialogs.    You must type in the full path name of the file containing the 
icon you want to use.    If the icon resides in an EXE or resource file, you must also click 
sequentially through all of the icons in the file to find the one you want.    IconManager's 
Install command and Drag-and-Drop capability eliminate the need to do all of this typing 
and clicking.



Norton Desktop Icons

Norton Desktop has several kinds of icons on the "desktop"; group, program and file icons 
in Quick Access group windows, programs or files directly on the desktop, tool buttons, and 
drive icons.    Only the icons in Quick Access group windows can be installed directly from 
IconMaster- these are the only ones which can be highlighted and use the Properties 
command.    

You can change the icons for programs and files on the desktop by first dragging them into 
a group window, changing the icon, and then dragging them back out.

Norton Desktop can only read icons from ICO and EXE files, and from DLL resource files that
resemble EXE files (NIL).    

When you install an icon into Norton Desktop, it makes itself a local copy for speed.    
However, you should keep the readable form around, in the same place it was originally 
read from, so that it can be reread whenever Norton decides it needs to refresh the icon 
cache.

Normally, when you want to install an icon into the Norton Desk top you use the Properties 
and Choose Icon dialogs.    You must enter the full path name of the file containing the icon 
you want to use.    If the icon resides in an EXE or NIL file, you must also scan through all of 
the icons in the file to find the one you want.    IconManager's Install command and Drag-
and-Drop capability eliminate the need to do all of this typing and clicking.



Program Icons

In addition to changing the icon used by the Program Manager in Group windows, you can 
change the icon that a program uses when it minimizes.

Most often the icon used by a program when it minimizes is the first icon in its EXE file, 
displayed in the upper left corner of the Preview window.    This is not always the case 
though, so you should compare the icons Preview shows with the actual icon a program 
minimizes to.

Sometimes the program will use an EXE icon other than the first one.    Sometimes it will use
an icon from a related DLL file.    In a few cases the minimize icon is not stored as a resource
at all.    When this aberrant form is used the icon can not be    changed.

To change the typical program's minimize icon, load the EXE file into a Preview window and 
drag a new icon, from another Preview window, onto the old one.    

CAUTION: changing the icon of a program while it is running is not recommended.    It could 
cause the program to crash!    Windows caches the EXE file while executing and it can 
become confused about where the program code actually resides.    Always make a copy of 
the program, change the icon in the copy, test the changed file, and only then discard the 
original file.

Windows 3.0 provides no means to change the icon displayed by minimized DOS programs. 
You could go into the WIndows file and change its DOS icon, but then all DOS programs 
would still minimize to the same icon.    There are, however, several shareware programs, 
such as NODOS and ICON-FIXER that solve this problem.    Windows 3.1 does handle this 
situation properly and the icon you assign in Program Manager or in Norton Desktop is used
when a DOS program minimizes.



Problem Icons

There are some programs which display icons when minimized for which IconMaster can not
extract an icon from the EXE file.    The usual cause is that the executable file does not 
contain a 32 X 32 16-color icon, which is the only kind that IconMaster can use.

Another cause is that the EXE file does not conform to Microsoft format standards.    An 
example is Word for Windows WINWORD.EXE.    (You didn't expect Microsoft to be consistant
did you?)    It seems to contain a monochrome icon only, but actually fails the test as a legal
Windows file -- even though Windows itself can find the icon.    Every icon editor we have 
tried has failed to find the icon.    Even the Whitewater Resource Editor considers it not to be
a legal Windows 3 EXE file.



Duplicate Icons

Since ICO and ZIP icons exist as individual files in a directory, they can not have duplicate 
names.    IML and IMZ files, however, can contain duplicate icon names.

 If you attempt to save an IML or IMZ that contains duplicate names as an ICO or ZIP, you 
will receive a Write dialog box requesting permission to overwrite.    This means that some 
duplicate named icon is going to be lost.    To avoid loosing an icon you should note the 
name of the duplicate, go back to the original IML or IMZ, rename duplicates, and save 
again.



EXE/DLL Icon Names

The names used for icons extracted from EXE and DLL files are the names found in these 
files, shortened to eight characters.      Not all such icons have text names.    Some have 
integer names.    Some have nothing and are simply named by their ordinal position in the 
file.



Optimizing Performance

There are several things that you can do to optimize the performance of IconMaster:

First, configure your system optimally;

1. Use a big disk cache!
IconMaster often has to re-read icons from the original disk files when scrolling with 
many many icons.    A big cache will dramatically improve performance.    It is far 
more important to have a big cache than to have huge amounts of free memory.

2. Use a RamDisk
IconMaster needs to have some place to write its Scratch files and to unZip IMZ and 
ZIP files.    Using a RamDisk makes a significant speed improvement.    The RamDisk 
should have at least several hundred Kbytes free.

Next, set up environment variables, before invoking Windows, to use temporary files 
optimally;

3. Set a TEMP environment variable to a RamDisk.
e.g.    SET TEMP=D:\
IconMaster uses the TEMP path, as does WIndows, to save all of its intermediate 
temporary files.

4. Set a PKTMP environment variable to a RamDisk.
e.g.    SET PKTMP=D:\
PKZIP uses this variable, not TEMP, to know where to put its working data.

Finally, give IconMaster some room to work;

4. Close other programs that consume a lot of GDI resources.

5. Close enough other programs to free up at least one megabyte of memory.



Saved State
Changing Screen Resolutions

IconMaster saves information about its operation in the file ICONMSTR.INI in your windows 
directory.    The saved information is the size and location of each window and the window's 
background color.    If you change the video driver screen resolution, it is likely that the next 
time you open IconMaster the windows will be in undesireable positions, or even off the 
screen.    No problem, just do the Windows-Tile command and all open windows will be 
resized and repositioned to match your new resolution.    You can then move them as you 
like.



Window Interactions

When an icon from a Preview window is being edited (as a result of the EDIT command or 
double clicking the icon), the same icon appears in both a Preview Window and in the Edit 
window.    This raises the possibility of some strange results.    

For example, what happens if the Preview version is renamed, deleted, or replaced by a 
Drag from another Preview window and then an Edited version is saved?    What happens to 
the Preview display if you edit and save the icon.    There are many such possible situations. 

To avoid such problems the Edit and Preview windows are linked.    Any change to a Preview 
window which currently has an icon being Edited which could possibly result in a problem 
will result in unlinking the Edit icon: you will be given a chance to first save any edits and 
the Edit window icon will be changed to Untitled.    Any saving of an edited icon will cause 
the linked Preview window to refresh.�

A similar situation could arise if the same file is simultaneously displayed in two or more 
Preview windows.    What happens if you alter one of them and save it?    Because there are 
some legitimate reasons why you might want to see the same file in multiple Preview 
windows, Preview windows are NOT linked with each other.    This means you should 
exercise great care when displaying the same file in multiple Preview windows.    In general, 
to be safe, do not alter or save from more than one of the windows.    If you do, you are 
likely to end up with a strange combination of the work done in each window.    Further 
more, it is possible for a window to generate an error if it tries to display an icon which has 
been deleted since the window was opened.



Window Versions

IconMaster has been tested with both version 3.0 and 3.1 of Windows. It will not work with 
Windows versions prior to 3.0.

IconMaster has also been tested with both Versions 1.0 and 2.0 of Norton Desktop for 
Windows.


